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SUMMARY

Fruit flies sense the features of food that are driven by particle size, including
smoothness versus grittiness, by deflection of sensilla decorating the labellum,
and md-L neurons. We describe adaptation of the Drosophila proboscis exten-
sion response assay, including steps to perform the taste tests and score behav-
ioral responses, to determine preferences to foods with different sized particles.
We also describe calcium imaging in GCaMP-expressing flies to assess the re-
sponses of md-L neurons to different levels of taste sensilla deflection.
For complete details on the use and execution of this protocol, please refer to Li
and Montell. (2021).

BEFORE YOU BEGIN

Stock food preparation

Timing: 10–30 min

1. Prepare stock sucrose solution, 500 mM.

a. Dissolve 34.2 g sucrose in 200 mL Milli-Q water, filtered with a 0.22 mm membrane.

b. Store in 1.7 mL tubes at �20�C. The frozen samples can be used for at least one year.

2. Prewash silica particle powders.

a. Place �0.2 g silica powder in a 1.7 mL tube, and add 1 mL Milli-Q water.

b. Gently rock the tube for 10 min on a 3D rocker, briefly spin the tube in a microcentrifuge, and

remove the clear supernatant. Repeat 3 times.

c. Dehydrate the particles in the tube with the lid open in a desiccator at room temperature for 2–

3 days.

Alternatives: Milli-Q water can be replaced by standard distilled water.

Starve flies for the proboscis extension response (PER) assays

Timing: 5 min for transferring flies

Timing: 2–3 h for starvation
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3. Flip 3–5 days-old flies into a vial (30–50 flies per vial) containing a wet tissue (e.g., Kimwipe) in the

bottom.

a. Starve the flies (typically 2–3 h) before testing.

Note: Longer starvation times increase the motivation to feed, thereby reducing the influence

of particle size on food appeal.

CRITICAL: Following eclosion, maintain the age-matched flies in fresh food vials (see key

resources table).

Prepare the glass tip to mechanically stimulate the labellum for the calcium imaging

experiments

Timing: 10 min

4. Pull glass needles to create tips that will be used to push the cuticle of the labellum, or to deflect a

taste hair. The needle should have an initial diameter of 1–3 mm, and a short (�3 mm) taper

(Figures 1A and 1B).

a. To achieve the correct diameter and taper using a Sutter Instruments P-97 puller, set the pro-

gram on the puller as follows: melting temperature of the glass needle plus 10�C (ramp +

10�C), pull force (pull 1), velocity of the pull (velocity 20), time setting for cooling (time 250).

b. Gently tap the tip in a vertical position on a piece of paper to break and widen the tip,

achieving an opening of �20–40 mm.

Figure 1. Preparation for performing calcium imaging on a fly head

(A) Pulled glass pipette tip. The space between the vertical lines is 10 mm, and 100 mm between 50 and 60.

(B) An example of the setup for performing calcium imaging.

(C) Glass slide with the wide end of a 200 mL pipette tip (top) and a glass slide with two layers of round punched stickers

(bottom).

(D) Image of the plastic stickers, grease, and a fly head loaded in the center of the well.
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Note: The needles can be used on more than one fly. However, prepare one per fly so there

are extra in case they break.

Note: See Figures S5D–S5H (Li and Montell, 2021) for deflection of the cuticle by a glass tip.

Prepare chambers for the calcium imaging experiments

Timing: 30 min

5. Prepare a circular plastic chamber by cutting �3 mm from the wide end of a 200 mL pipette tip

(Figures 1C and 1D).

Note: Prepare 5–10 chambers so that extras are available if a chamber breaks or is contami-

nated with debris.

6. Place the 3mmwide end of the tip on a glass slide with wet nail polish to immobilize the chamber.

Let the nail polish dry.

Alternatives: Stick two layers of circular plastic stickers on a glass slide to make a small well

(Figures 1C and 1D).

13 PBS preparation

Timing: 10 min

7. Add 5 mL 103 PBS (Thermo Scientific� Phosphate-buffered saline; PBS, 103, pH 7.4) to 45 mL

Milli-Q water to make a 13 PBS solution. Store at room temperature for up to 4 weeks.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

Sucrose Sigma-Aldrich Cat # S0389

Monodisperse silica microspheres,
diameter 9.2 mm

Cospheric, Co. Cat # SiO2MS-2.0 9.2 mm

103 PBS Fisher Scientific Cat # AAJ62036K2

Agar Genesee Scientific Cat # 66-104

Dry yeast MP Biomedicals Cat # ICN90331280

Soy flour Genesee Scientific Cat # 62-115

Cornmeal LabScientific Cat # NC0535320

Corn syrup Genesee Scientific Cat # 62-109

Ethanol Gold Shield Cat # 1016-4233

Tegosept Genesee Scientific Cat # 20-259

Propionic acid Acros Organics Cat # 200001-092

Phosphoric acid Sigma-Aldrich Cat # 438081-500MI

Experimental models: Organisms/strains

Male and female Drosophila melanogaster
(3–5 days old) w1118

Bloomington Drosophila Stock Center RRID:BDSC_3605FBst0003605
Cat # BL5905

Male and female Drosophila melanogaster
(3–5 days old) tmc-Gal4

(Zhang et al., 2016) RRID:BDSC_66557
Cat # BL66557

Male and female Drosophila melanogaster
(3–5 days old) UAS-GCaMP6f

Bloomington Drosophila Stock Center Cat # BL42747
Other GCaMP fly lines can also be used.

(Continued on next page)
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MATERIALS AND EQUIPMENT

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Male and female Drosophila melanogaster
(3–5 days old) UAS-tdTomato

Bloomington Drosophila Stock Center Cat # BL36327

Software and algorithms

ZEN SP5 ZEISS N/A

Fiji (Schneider et al., 2012) https://imagej.net/software/fiji/downloads

Prism 8 GraphPad https://www.graphpad.com/guides/
prism/8/user-guide/index.htm

Linlab 2 software Scientifica https://www.scientifica.uk.com/products/
scientifica-linlab-2

Other

Motorized micromanipulator Scientifica PatchStar N/A

Microcentrifuge Model 5418 Eppendorf Cat # 05-401-201

Milli-Q Reference Ultrapure water
purification system

MilliporeSigma N/A

Glass capillaries World Precision Instruments Cat # 1B150F-3

Silicone lubricant Dow Corning Cat # DC976

Bel-Art� SP Scienceware� Space Saver
Vacuum Desiccator

Fisher Scientific Cat # S43284

Parafilm Fisher Scientific Cat # S37440

Rubber tubing (soft) 6 mm ID, 8 mm OD. Ordered on Amazon. Use any brand of soft
rubber tubing with the appropriate size to
connect to a 1 mL pipette tip to make the
air duct for aspirating flies.

Cotton wool Genesee Cat # 51-101

Vannas Spring Scissors Fine Science Tools Cat # 15000-04

Forceps Fine Science Tools Cat # 11295-10

W Plan-Apochromat 203 1.0 NA water-
immersion objective

ZEISS Cat # 421452-9800-000

Upright confocal microscope Zeiss LSM700 N/A

3D rocker Benchmark Scientific B3D 1308

Self-adhesive hole reinforcement stickers,
1/400 diameter hole punch reinforcements

Every N/A

Gardens nail enamel, clear water base Honeybee N/A

Micropipette puller Sutter Instruments Cat # P-97

Pipette tips 10 mL Olympus Reach Tip Cat # 24-121RL

Pipette tips 200 mL Olympus Reach Tip Cat # 24-150RL

Pipette tips 1000 mL Olympus Reach Tip Cat # 24-165RL

Kimwipes Fisher Scientific Cat # 06666A

Centrifuge tubes 1.7 mL Thomas Scientific Cat # 1159M35

Olympus 0.6 mL microtubes Genesee Cat # 22-272

Fly food recipe

Reagent Final concentration Amount

Agar �8.3 g/L 380 g

Dry yeast �16.5 g/L 758 g

Soy flour �9.6 g/L 442 g

Cornmeal �70.0 g/L 3,218 g

Corn syrup �69.0 g/L 3,173 g

Ethanol �1.0% 480 mL

Tegosept �3.1 g/L 144 g

Propionic acid * �0.47% 216 mL

Phosphoric acid * �0.037% 17 mL

(Continued on next page)
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CRITICAL: *Pure Propionic acid and phosphoric acid are corrosive to the skin and eyes.

STEP-BY-STEP METHOD DETAILS

Part 1: Proboscis extension response assay

Prepare fresh particle food

Timing: 5 min

This section describes the preparation of the particle food solution for the following behavioral tests.

1. Prepare a 50 mM sucrose solution from a 500 mM sucrose stock solution by adding 950 mL water

to 50 mL 500 mM sucrose solution.

2. Weigh the silica microsphere powder (�2–4 mg).

3. Transfer the particles to a 0.6 mL microfuge tube.

4. Add 50 mM sucrose solution (20–40 mL depending on exactly how much silica is weighed out) to

make a 10% w/v particle solution.

5. Mix by pipetting with a 10 mL pipette tip for 5 s.

Note: Seal the tube with parafilm, store at room temperature, and use within 3 days of

preparation.

Trapping flies in a pipette tip

Timing: 20–30 min

This section describes how to prepare flies for the taste assays.

The PER assays are performed after immobilizing the flies in a pipette tip as described below and

demonstrated in Methods video S1. The 20–30 min is the time required to immobilize �24 flies

(�12 flies/group). The PER assays are performed after the fly preparations are done. Repeat steps

7-12 as needed depending on how many flies are to be tested. Beginners may take �2 min to pre-

pare one fly. After practice, this typically requires only 30–60 s per preparation.

6. Attach a 1 mL pipette tip to soft rubber tubing with the narrow side pointing out.

a. Trim the narrow side of the 1 mL tip slightly with a razor blade to allow an individual fly to be

introduced (Figure 2A; Methods video S1).

b. Attach another 1 mL pipette to the other side with the wide end sticking out. This latter end is

used to mouth aspirate (Figure 2A).

7. Aspirate a fly into the 1 mL pipette tip (Figure 2A).

8. Attach a 200 mL tip to the end and expel the fly into the 200 mL pipette tip.

a. Gently shake the pipette tip downward while blowing out the air to trap the fly in the end of the

tip with the fly head towards the open end (Figure 2B).

Note: The head should be slightly loose.

Continued

Reagent Final concentration Amount

H2O N/A 45 L

Total N/A �46 L

The fly food can be stored for 2–3 days at room temperature, or up to 10 days at 10�C.
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9. Using a razor blade, make a horizontal cut to remove any extra tip material above the fly head

(first cut, Figure 2C).

10. Draw the fly back slightly from the end of the 200 mL by gentle inhalation, before introducing a

second cut at an angle (Figure 2C),

11. Expel air to push the fly head a little out over the open end of the tip so that the labellum only is

exposed.

a. Remove the 200 mL tip from the apparatus.

Note: The legs should be hidden inside of the tip.

12. Insert a very small cotton ball with a sharp wooden stick under the fly to immobilize it (Figure 2C).

Note: It may be necessary to try a second or third fly to obtain a fly with the proper orientation.

Do not jam the fly too hard at the end of the 200 mL tip.

Note: Place each individual fly preparation on a wet paper towel to keep the fly hydrated if you

do not use the fly immediately.

Note: If the flies are properly fixed, they will survive overnight in a humidified chamber (a tip

box containing wet paper, e.g., a Kimwipe). However, it is best to use the flies right away.

Alternatives: The sharp wooden stick (step 12) can be replaced with a 10 mL pipette tip over-

laid with the top half of a second 10 mL pipette tip, which can reach the inside tip of the 200 mL

pipette.

CRITICAL: To avoid damaging the fly labellum, be careful to inhale gently to withdraw the

fly slightly from the end of the 200 mL pipette (step 7).

Proboscis extension response assay

Timing: 15 min (for step 13–18)

This section describes how to perform the taste tests and score the behavioral responses.

13. Saturate the fly with water before performing a PER assay with sugar/particle food.

a. To test if each fly is water saturated, offer each fly a drop of water at the end of a 10 mL

pipette tip.

Figure 2. Introducing a fly into a pipette tip for performing PER assays

(A) Apparatus for aspirating a fly into a 1 mL pipette tip.

(B) Aspirate the fly into a 200 mL pipette tip.

(C) A fly immobilized for performing a PER assay.
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Note:Wild-type and w1118 flies usually do not drink upon water application. �10% of the flies

drink water %5 s and then do not drink the second offering of water.

Note: Flies that drink water >5 s are discarded (typically <1% of the flies tested).

14. Mix the particle food in the 200 mL microfuge tube by pipetting for 3 s.

15. Withdraw 2 mL of the particle food into a 10 mL pipette tip. Pipette the particle food in and out of

the tip 2–3 times to mix the contents.

16. Make contact between the labellum and the drop at the end of the tip (Figure 3A). The contact

time is �0.2–0.6 s. The liquid drop should be quickly withdrawn from the fly to allow full exten-

sion of the proboscis (Figure 3B).

17. As a control, perform PER assays using 50 mM sucrose alone with a parallel group of flies.

18. Test all the flies with 500 mM sucrose alone. Flies that do not respond should be discarded.

19. Score the responses as follows:

a. 1—The fly fully extends its proboscis and consumes food for R1 s (Figure 3; can see the

esophagus moving).

b. 0.5—The fly extends its proboscis and consumes food for <1 s.

c. 0—The fly fails to extend its proboscis.

20. Each trial (n=1) includes R 12 flies.

Note: Based on the effect size comparing control flies and tmem63 mutants (Li and Montell,

2021), R8 flies are required. For comparing other mutants with control flies, we recommend

R 12 flies in case the effect size is smaller.

21. The PER index is calculated as:

a. PER = ðsum of the scoresÞ=ðnumber of flies testedÞ

Repeat the experiments 5 times on different days.

Note: See below for more information on how to calculate and display the PER data

(expected outcomes; Figure 9, Table 1).

Part 2: Calcium imaging of md-L neurons

When the fly proboscis contacts liquid food, �3–4 L-type hairs per labium are deflected. The

bending angles of the hairs cause curvature at the base of multiple sensilla and induce mechanical

stimulation of md-L neurons. The angle of deflection of the hairs by food mixed with particles is

larger compared with clear food. In this assay, we push the cuticle to deflect multiple hairs with

Figure 3. Images of fly responses to particle food

(A) Particle food contacting the labellum.

(B) Fly extending its proboscis to ingest particle food.
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various degrees of intensity to mimic the force on the labellum conferred by the grittiness in the

food. Refer to Li and Montell (2021).

Genetic crosses

Timing: 2 weeks (for step 22)

This section describes the genetic crosses to obtain flies for performing calcium imaging on md-L

neurons.

22. Cross tmc-Gal4 flies with the UAS-GCaMP6f,UAS-tdTomato line or alternatives (see below).

23. Collect 20–30 F1 flies (UAS-GCaMP6f,UAS-tdTomato/+;tmc-Gal4/+).

24. To make sure that the flies are healthy and are a consistent age, 1 day before dissecting the

heads, transfer 3–5 day-old flies to a fresh vial.

Note: It is acceptable to use older flies, as long as the ages are consistent among the

genotypes.

Note: UAS-GCaMP6f,UAS-tdTomato/+;tmc-Gal4/+ flies express the fluorescence proteins

tdTomato, which is red, and the GCaMP6f, which is green, in the md-L neuron located in

the middle of each labellum.

Alternatives: In this example, the UAS-GCaMP6f and UAS-tdTomato transgenes are recom-

bined onto a single chromosome. Other versions of GCaMP (including GCaMP7 and

GCaMP8) can be used. For the baseline control, other fluorescent proteins (such as UAS-

mCherry) can be used.

Fly head dissection and specimen preparation

Timing: 10 min (for step 25)

This section describes the procedures for dissecting and preparing fly heads for calcium imaging.

25. Obtain the chambers previously prepared and silicone lubricant. Place a drop of silicone lubri-

cant in the middle of the chamber (see above: ‘‘prepare chambers for the calcium imaging ex-

periments.’’

26. Briefly anesthetize the flies by injecting CO2 into the vial or by incubating the vial on ice for 2–

3 min.

27. Withdraw the fly by grabbing its wings with forceps and place it in a dissection well containing

13 PBS.

28. Dissect the head away from the body by cutting the neck with fine scissors.

29. Incubate the isolated head for 5–8 min in PBS until the proboscis fully extends and the labellum

is in a closed state (Figure 4A).

30. Transfer the fly head from dissection well to the chamber. Immobilize the fly head in the silicone

in the chamber.

31. Orient the head on one side with one eye facing up.

32. Pick the fly head with labellum in a closed state using forceps (Figure 4A).

a. Hold the head carefully with one side facing up.

b. Attach one side of the labellum to the grease so that the labellum sticks to the grease.

Note: If the proboscis is contracted, then hold the head and pull back slightly to fully extend

the proboscis, and attach the head on the grease so that one side of the labellum remains flat
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and unfolded (Figure 4B), and adjust the grease beneath the sample to make the labellum

horizontal.

33. Add a drop of water (�60 mL) to the chamber.

Note: Keep the labellum flat and stretched in a horizontal position to help visualize the posi-

tion of the labellum and sensillum as you apply force. If the labellum curls up (Figure 4C), use a

new preparation.

Note: After sticking the extended proboscis on the silicone lubricant, remove any bubbles

around the labellum, which would interfere with the imaging.

CRITICAL: Be careful not to damage the labellum when removing the head with the for-

ceps and scissors.

Live confocal microscopy

Timing: 10–20 min per sample (for step 34)

This section describes the confocal microscopy setup, and the methods to record the responses of

md-L neurons due to mechanical stimuli.

34. For imaging experiments, use a laser scanning confocal microscope and perform the imaging at

room temperature (�23�C).

Note: We used a Zeiss LSM 700 upright confocal microscope with a w Plan-Apochromat 203

/1.0 water objective and 1.93 optical zoom. Set the pinhole to 2.07 Airy Units = 4.1 mm section

and scan at 614.4 ms per frame in line at 8 bits (Figure 5).

Figure 4. Images of dissected fly heads

(A) Dissected fly heads floating and incubating in 13 PBS. The blue arrows point to labella in an open state, while the

yellow arrows point to labella in a closed state.

(B) An example of a fly with the labellum in a flat and unfolded position (yellow arrow).

(C) An example of a fly head positioned on silicone lubricant with the proboscis extended and with the labellum curled

up (blue arrow).
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Figure 5. Panel settings on the Zeiss LSM 700 for live image recordings
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35. Set the ZEN SP5 software to acquire the images at 256 3 256 pixels. With these settings, the

pixel sizes are 0.67 mm 3 0.67 mm and the image sizes are 171.8 mm 3 171.8 mm.

a. Use the 488 and 555 nm laser excitation lines to image EGFP and tdTomato, respectively.

b. Acquire the bright-field image using the tdTomato channel (Figure 5). Set the time series to

record 3 images on the three channels at 614.4 ms intervals.

Note: To obtain the highest spatial resolution with the highest temporal resolution (fastest scan-

ning speed), we chose 2563 256 pixels, and limited the scanning area to the region containing

only the labellumand the extruded hairs. The somaof themd-L neuronwill cover�200pixels with

the LSM700 set at a scanning frequency of 614.4 ms. For other confocal microscopes, adjust the

image pixels and the scanning frequency to so that it is in the range of dozens to hundreds of ms.

36. Place the slide with the plastic chamber containing the head on the microscope stage under the

203 water immersion objective (Figure 6A).

37. Place the end of the glass tip on the cuticle between the L8 and S6 sensilla (Figure 6B; S6 not

visible in this image. Adjust focus to visualize S6).

38. Begin recording theGCaMP6f, tdTomato fluorescence signals, and the bright-field at the same time.

39. To provide a baseline, record R5 frames before introducing the mechanical stimulus.

40. Using the glass tip that is touching the cuticle, apply mechanical force by controlling the step

distances in one direction (5–40 mm) with a motorized micromanipulator and Linlab 2 software.

a. Push the glass tip on the labellum in the proximal direction (Figure 7B).

b. The duration of each stimulus is 2 s, which is the total time for stepping in and out.

c. The step distances are measured using video recordings of the bright-field images and Zeiss

confocal software, or Fiji software.

41. Save the videos using the .lsm format.

Note: The L8 and S6 sensilla are in the middle distal region of the labellum (see trouble-

shooting section; Figure 11). L8 is on the top layer of the labellum, while S6 is on the bottom

Figure 6. Preparation for performing calcium imaging on md-L neurons

(A) The setup for applying mechanical force to the labellum. The glass pipette tip is controlled by a motorized

micromanipulator. The GCaMP6f responses are monitored using a 203 water immersion objective.

(B) A glass tip pointing at the labellum. The L7, L8 and L9 sensilla are indicated.
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layer. After placing the glass tip on the cuticle between L8 and S6, and before applying me-

chanical stimuli, re-adjust the focus on the md-L neuron cell soma and start recording.

Because the soma of the md-L neuron soma is located near the middle of the labellum, the

glass tip can still be seen on the screen.

Note: Set the XYZ parameters on the Linlab 2 software (5–40 mm for one direction and 0 for the

other two directions) to control the motion distance in each direction.

Optional:The indentationdistances on the cuticle (10–40mm; see Figure 10A),which areproduced

by the motion of the glass tip, are measured with software on the confocal microscope (Figure 7).

Image processing

Timing: 20–30 min

This section describes the processing of calcium imaging videos of md-L neurons using Fiji software,

and the analysis of the neuronal responses to obtain curves showing the Ca2+ dynamics.

42. Drag the .lsm file to the Fiji control panel to load the file, and select: Image>Color>Split chan-

nels (Figure 7A).

Figure 7. Image alignment

Align the soma of the md-L neuron in the calcium imaging videos using the template matching plugin in Fiji.

(A) Fiji control panel and selection of the Split Channel menu option.

(B) Split the videos into the tdTomato (left), bright field (middle) and EGFP (right) channels.

(C) Combine the split tdTomato and EGFP image stacks in the same frame and select the ROI using the tdTomato signal as the landmark for the

alignment, ROI is selected as a rectangular yellow box shown in the figure.

(D) Align slices dialog box.
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43. Combine the tdTomato and EGFP channel files into one video by selecting: Image>Stack-

s>Tools>Combine (Figure 7B).

44. Align the positions of the md-L neuron in the video using the template matching plugin of Fiji.

a. To do this, select the tdTomato signal in the soma of themd-L neuron as the region of interest

(ROI; Figure 7C).

b. Then select Plugins>Template Matching>Align slices in stacks (Figure 7D).

45. Obtain the fluorescence intensity in separate time series stacks for both the tdTomato and EGFP

signals in the soma of the md-L neuron. Select Plugins>Time series analyzer V3 (Figure 8).

46. Select a rectangular region including the md neuron soma, and add it to the ROI manager.

Figure 8. Data analysis

Calculate the average EGFP fluorescence signal in the selected ROI using the time series analyzer plugin in Fiji.
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47. Click ‘‘Get Average’’ (Figure 8) to obtain the average signal intensity of the series of images in

the stack. Use the same ROI to analyze the tdTomato and EGFP signals.

48. Based on the bright field images showing the pushing of the labellum by the glass tip, the peak

intensity of the GCaMP fluorescence is shown at the time point when eachmechanical stimulus is

applied on the labellum.

49. Select the bright field images at the base and at each peak stimulus (Figure 10A). Use the Im-

age>Lookup tables>Thermal to display the heatmap of the GCaMP and the tdTomato images

(Figure 10B).

50. Calculate the changes in fluorescence using the following formula:

DR

R0
= ðR � R0Þ

�
R0

R0 =
F0ðGFPÞ

F0ðtdTomatoÞ
The GCaMP fluorescence (F) is normalized to the tdTomato fluorescence:

R = FðGFPÞ=FðtdTomatoÞ
The base GCaMP and tdTomato fluorescence (F0) are obtained from the average of the 5 frames

before the stimulus is applied.

An average response curve G SEM is shown in Figure 10C.

EXPECTED OUTCOMES

Wild-type or w1118 flies starved for 2 h exhibit a modest PER score in response to 50 mM sucrose

(0.35G 0.04 from 5 trials). The PER score using 50 mM sucrose containing 9.2 mMparticles increases

significantly (0.77 G 0.04) (Figure 9, Table 1). For more data, refer to Li and Montell (2021).

Mechanical stimulation (10–40 mm steps) of the cuticle on the labellum should induce an intensity-

dependent increase [Ca2+]i in the soma of the md-L neuron (Figure 10).

Figure 9. PER indexes of flies exposed to 50 mM

sucrose alone or 50 mM sucrose containing 9.2 mm

particles (10% w/v)

Means G SEMs. **p<0.01. n=5 trials. R12 flies/trial.

Non-parametric Mann-Whitney test between the

group offered 50 mM sucrose plus particles and the

control offered 50 mM sucrose only. The data points

are shown in Table 1.
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QUANTIFICATION AND STATISTICAL ANALYSIS

The data analyses are described in the step-by-step methods. In general, the experiments should be

repeated R5 times. More replicates are necessary to detect a smaller effect size in the presence of

greater variability. The specific number of replicates will require performing power analyses: set type

I error rate (a) as 0.05, power (1-b) as 0.9. If the mean is 1, and the standard deviation is 0.5, you will

need 5 samples per group. The results from the PER assays and calcium imaging assays should be

expressed as the mean G SEM. We use PRISM8 to apply the distribution-free nonparametric Mann-

Whitney tests because each sample is independent and the sample sizes are small, as outlined in the

experimental design described in this protocol.

LIMITATIONS

PER assay

The PER assay is a quick behavioral response to evaluate how appealing a given food is to a fly. De-

pending on the rearing conditions and the genetic background, it may be necessary to adjust the

starvation time or sucrose concentration to achieve robust PER scores.

To evaluate the impact of grittiness on food appeal, monodisperse silica microspheres have the

advantage that they do not elicit a gustatory response. However, a limitation is that the silica parti-

cles (e.g., 9.2 mm in diameter) added to the 50 mM sucrose do not form a stable colloidal solution.

Therefore, it is necessary to mix the particles in the solution immediately before offering the food to

the flies.

Table 1. Example of raw PER data for 5 groups of flies using either clear food (sucrose alone) or smooth food with 9.2 mM particles

Food type Group A B C D E

50 mM sucrose Sum of the scores 5 5.5 4 3 4

Number of flies in each group 12 12 12 12 14

PER index 0.42 0.46 0.33 0.25 0.29

50 mM sucrose + particles Sum of the scores 9 7.5 10 9.5 10

Number of flies in each group 12 12 12 12 12

PER index 0.75 0.63 0.83 0.79 0.83

The ‘‘sum of the scores’’ is the sum of all of the PER scores for each group.

Figure 10. Calcium imaging of the md-L neuron during exposure to mechanical stimulation

(A) The cartoon (top row) depicts mechanical stimuli applied to the labellum by pushing a glass tip on the cuticle,

resulting in deflections of 10–40 mm. The bottom row shows the corresponding bright field images of the labellum.

(B) Heatmap of the GCaMP responses of the md-L soma prior to the stimulus, and at the peak responses using the four

levels of force shown in A. Scale bar: 20 mm.

(C) Response curves for the GCaMP6f and tdTomato fluorescence as mean G SEM, n=5. The gray arrows indicate the

peak responses shown in B. The blue, pink and purple arrows show the time that the four levels of force were applied

to the cuticle as indicated in A.
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Calcium imaging with GCaMP

This protocol involves applying force by indenting the cuticle to elicit a calcium response in the md-L

neuron. The indentation results in deflection of the nearby sensilla. It is also feasible to deflect a sin-

gle sensillum such as L7 (Li and Montell, 2021). Identifying specific sensilla requires experience. In

addition, the deflection angle of the sensillum can only be measured from the two-dimensional

images.

It is not feasible to use food droplets to stimulate sensilla on the labellum while imaging the md-L

neuron soma, because this would require using an air lens and sealing the labellum under a cover

glass.

It is critical that the labellum is not damaged prior to performing the imaging.

TROUBLESHOOTING

Problem 1

The flies do not exhibit a PER to 50 mM sucrose. Refer to part 1: proboscis extension response assay:

step 16.

Potential solution

Extend the starvation time or increase the sucrose concentration. Also, check if the fly is damaged. If

so, dispose of the fly and use a different one.

Problem 2

The flies drink water >5 s during the water saturation protocol. Refer to part 1: proboscis extension

response assay: step 13.

Potential solution

The fly food on which the flies are reared may be too dry. This will require adding more water to the

recipe or incubating the flies in a humidified chamber.

Problem 3

The labellum extends out and trembles. Refer to part 1: proboscis extension response assay: steps

11 and 12.

Potential solution

The flymay be squeezed too tightly in the pipette tip or the labellummay be damaged. If so, dispose

of the fly.

Problem 4

Cannot recognize specific sensilla on the labellum. Refer to part 2: calcium imaging of md-L neuron:

steps 36 and 37.

Potential solution

Orient the labellum horizontally, and adjust the focus to visualize two rows of sensilla on the labellum

(note that it is difficult to see both rows in one image). L8 is in the top row and is flanked by the I7 and

I8 sensilla (Figure 11A). The lower row includes multiple S-type sensilla including S6, which is in be-

tween L3 and L4, and is also flanked by S5 and S7 (Figure 11B).

Problem 5

Cannot identify the md-L neuron. Refer to part 2: calcium imaging of md-L neuron: step 36.
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Potential solution

The soma of the md-L neuron is located in the outer layer of the middle part of labellum in approx-

imately the same layer of focus as the two rows of sensilla (Figures 6 and 11B). Use tdTomato, which is

much brighter than GCaMP6f, to visualize the md-L soma and the many dendrites that extend to

most L-type sensilla.

Problem 6

The md-L neurons do not exhibit a calcium response. Refer to part 2: calcium imaging of md-L

neuron: steps 40 and 50.

Potential solution

The labellum may be damaged or the tip may also not be making contact in the right place. There-

fore, carefully dissect the head. Normally, the md-L neuron remains responsive for at least 30 min.

Problem 7

Check the health of the preparation for calcium imaging. Refer to part 2: calcium imaging of md-L

neuron: step 36.

Potential solution

An abnormally high basal level of GCaMP6f fluorescencemay indicate that the neuron is damaged. If

the basal level of GCaMP6f fluorescence is undetectable, this indicates that the neuron has died.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Craig Montell (cmontell@ucsb.edu).

Materials availability

This study did not generate new unique reagents.

Data and code availability

This study did not generate new datasets or codes.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2022.101806.

Figure 11. Images of a fly labellum, with the identities of several sensilla in the middle indicated

(A) Top row of sensilla on the labellum.

(B) Lower row of sensilla on the labellum.
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